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 1 Introduction
SensorLab software is used to make measurements from sensors, such as Temperature, Light and 
Sound.

Sensors are represented by icons, like these:

          Temperature Light         Sound

Measurements can be displayed as numbers and gauges.
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Measurements can be logged using two simple buttons:

The green button starts logging

The Red button stops logging

These buttons perform similar functions to those on popular LogIT data loggers.

Logged measurements can be viewed and analysed using graphs and tables.

SensorLab User Guide 8 April 2011 Page 6



 2 Supported Operating Systems and Hardware
SensorLab software is cross-platform (it is available for a number of different operating systems). 
These are:

● Linux
● Mac OS X
● Microsoft Windows

SensorLab supports most recent releases of these operating systems. 

Further details are available in the installation guide (PDF file) for each operating system.

 2.1 Computer Specification
Any computer hardware which runs one of the supported operating systems should run SensorLab 
equally well.

SensorLab has been designed to work with small screen Netbook computers, such as the Acer Aspire 
One and Asus Eee series. 

The minimum computer specification required to run SensorLab is:
● Screen VGA (640 x 480 pixels) in 16-bit colour (64,000 colours)
● Processor speed 1 GHz single core
● Hard disk space 5 to 15 Mbytes depending on operating system
● Memory Depends on the operating system

■ Linux typically 512 Mbytes
■ Mac OS X 256 Mbytes for 10.4, 512 Mbytes for 10.5, 1 Gbyte for 10.6
■ Windows 256 Mbytes for 2000 and XP, 1 Gbyte for Vista and 7

● Ports 1 free USB port (or serial port for older logger)

 2.2 Linux
SensorLab should run on most recent Linux distributions. However, there are a great many Linux 
distributions and we can not guarantee compatibility with all of them. SensorLab has been tested with 
a number of popular distributions, including: Fedora 9, Linpus Linux Lite 1, Mandriva 2008 and 
OpenSUSE 11. Further details can be found in the SensorLab installation guide (PDF file).
Check www.logitworld.com for the latest information on supported distributions.

 2.3 Mac OS X
The Mac OS X version of SensorLab runs on both Intel and PowerPC based Macs, which have Mac 
OS X 10.4 (Tiger), 10.5 (Leopard) or 10.6 (Snow Leopard).

 2.4 Microsoft Windows
The Windows version of SensorLab runs on Windows 2000, Windows XP, Windows Vista and 
Windows 7.
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 2.5 Consistent Across Platforms

Linpus Linux

Mac OS X

Windows XP
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 3 Installing SensorLab
SensorLab is supplied with installation packages for each supported operating system.

Full installation instructions are supplied in separate PDF files.

If your computer does not have a CD ROM drive, the software can be installed by one of these 
methods:

● Connect an external USB CD ROM drive and use the supplied CD.
● Transfer the software from CD to USB flash drive (sometimes called a keyring memory or 

memory stick) using a different computer, then install from the USB flash drive.
● Download a copy of the software from www.logitworld.com

Please note that SensorLab runs in Evaluation mode until activated. 

SensorLab is provided in two basic formats:
● Installation Package
● Manual Installation 

The Installation Package follows normal conventions to install the software. See “Installer” folder.

The Manual Installation format provides raw files for manual installation and, in some cases, provides 
a means of running the software without the need to install it first. See “Program” folder.

The ability to run the software without installation allows it to be used directly from a USB memory 
device. Unless the computer's security prevents you from doing so, you should just be able to walk up 
to a computer, connect a USB memory device containing the SensorLab program and run SensorLab.

 3.1 Linux
Installation on Linux is a little bit more complex than the other platforms, primarily because of the 
way tight security does not allow free access to Serial and USB ports. It is therefore highly 
recommended that you read the installation instructions document very carefully. 

 3.2 Mac OS X
The Mac version has a conventional installation package. The program can be copied to the 
Applications folder with a simple drag and drop, but that does not set up USB handling so the program 
will run but may not communicate with loggers and sensors.

 3.3 Microsoft Windows
Installation on Windows uses a conventional “Setup” program. An MSI file is included for network 
managers. SensorLab can also generally be run without installation by double clicking on the 
SensorLab program in the “Program” folder of the distribution CD.
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 4 SensorLab Editions
SensorLab can have either Standard functionality or Plus functionality. The following table highlights 
the major extra features found in SensorLab Plus and includes a comparison with LogIT Lab 4.

Features LogIT Lab 
version 4

Sensor Lab 
Standard

Sensor Lab 
Plus

Windows 2000, XP, Vista, 7 Yes Yes Yes

Mac OS 10.4, 10.5 or 10.6 No Yes Yes

Linux (selected distributions) No Yes Yes

Bluetooth, Serial and USB Yes Yes Yes

Bundled with most loggers Yes Yes No

Site licence Optional In bulk packs only Optional

Support all LogIT loggers Universal only No Yes 1

Resources / worksheets Hyperstudio only Any format Any format

Set up template files No No Yes

Calculate data with user formula No No Yes

Absolute time and date in table No No Yes

Variable smoothing No No Yes

Analysis tools Reading
Difference
Gradient
Area

Position
Reading
Change 2

Gradient
Area

Position
Reading
Change 2

Difference
Gradient
Area

Standard deviation No No Yes

Function plotting Straight line fit
Differentiation
Integration

Straight line fit
Differentiation
Integration

Straight line fit
Differentiation
Integration
Difference
Product

Overlay oscilloscope traces No No Yes

Overlay data from file No No Yes

Table highlight tracks cross hair No Yes Yes

Overlapping timing events No Yes Yes

Create set up template file No No Yes

Select channel colours No No Yes

Select colour theme No No Yes

Time and date on X axis No No Yes

Notes:
1 Limited support for LogIT model SL (no remote set up)
2 Change tool was known as Difference tool in LL4. SensorLab has new difference tool.
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 4.1 Standard and Plus Editions
SensorLab Standard is generally included with LogIT data logging systems and has a similar level of 
functionality to the earlier LogIT Lab 4 software. 

SensorLab Plus is purchased as additional software. It has extra features and generally includes a full 
site licence. The extra features include support for all LogIT data logging systems. 

 4.2 Licence
In addition to being available with Standard or Plus features, SensorLab is also supplied with either a 
Single User Licence or a Full Site Licence.

A single user licence entitles the purchasing organisation to run one copy of SensorLab on one 
computer at a time. This can be on any one of the supported operating systems.

A site licence entitles the purchasing organisation to run any number of copies of SensorLab on any 
number of computers, with any supported operating system, at the purchasing organisation's single 
postal address. In addition, it can be run on any computers belonging the the purchasing organisation 
but temporarily used away from the organisation's postal address. It can also be used at home by staff 
and students of the purchasing organisation.

Full licence details are shown by selecting Software Activation from the File, Administrator menu.
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 5 Activation
SensorLab runs in Evaluation mode with most loggers and sensors until activated. 

SensorLab version 1.1 is supplied pre-activated for uLog USB Sensors.

Evaluation mode enables the software to be evaluated before purchase. The evaluation version can 
also be downloaded and used to update an earlier installation. To evaluate SensorLab Plus select 
“Evaluate SensorLab Plus” from the Help menu.

In evaluation mode there are a number of limitations:
● Printouts are defaced
● Logged data can not be saved
● Logging is limited to a maximum of 8 minutes in duration

Activation enables functionality according to the licence purchased. There are two levels of 
functionality:

● Standard
● Plus

SensorLab Standard is generally included with LogIT data logging systems and has a similar level of 
functionality to the earlier LogIT Lab 4 software. The supplied licence may be for a single user or for 
a complete site. Generally SensorLab Standard only supports the data logging system it is supplied 
with.

SensorLab Plus is purchased as additional software. It has extra features and generally includes a full 
site licence. The extra features include support for all LogIT data logging systems. For a full list of the 
major extras features, see the section “SensorLab Editions”.

At any time, in Manager mode, the Activation option is available from the File, Administrator menu. 

Once the licence terms have been accepted, the activation details may be entered. First enter Name, 
Organisation and Post/zip code details, then enter the activation code and click Apply. More than one 
activation code can be entered in this way. This may be necessary if the software is initially purchased 
as single user, then a site licence upgrade is purchased.

Activation code details can be found on the licence sheet supplied with SensorLab software.

Technical Note:
Activation details are stored in a simple text file. To enable activation for all users of the computer, a 
second copy of this file needs to be stored in a central location. In some cases this is achieved by a 
user with Administrator privileges activating the software, in other cases it is necessary to copy the file 
manually. A prompt is given if this latter method is required. Network administrators may need to 
distribute the file to all their computers. Further details can be found in the separate installation 
document (PDF file).
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 6 Levels of Sophistication
SensorLab can be set to one of four levels of sophistication. Level four is the most sophisticated.

The level is usually displayed at the bottom right of the screen by one of the icons 
shown here.

Clicking on the Level icon causes the level to cycle up to the next most sophisticated, 
or cycle from level 4 around to level 1.

At lower levels the display is simplified, with less menu items and icons, a simple bold graph format is 
used and default display features, such as the table, are turned off or replaced by simpler alternatives.

The program start up level can be set for all users with the Administrator Settings option in the File 
menu. If the “Administrator's Settings” menu item is not shown, the Settings dialogue can be opened 
by pressing the key combination Shift/Ctrl/Alt/T.

Administrator Settings also has an option to  “Allow users to save options”. With this enabled 
individual users can set their own start up level using Options from the Tools menu.

If Administrator's Settings is not shown in the Administrator menu, the software is probably not in 
Manager Mode. Manager mode shows menu items which a system administrator might prefer to hide 
from users. In such cases Manager mode can be turned off using Administrator's Settings. To turn 
Manager mode back on or to access other Settings, press the key combination Shift/Ctrl/Alt/T.
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 7 Measuring and Logging
When SensorLab starts up it will look for any suitable data logging equipment connected to the 
computer. It will check USB connections and, where appropriate, the configured serial port.

If data logging equipment is found it will be shown as 
icons representing the sensors and interface. Below these 
are gauges indicating the current measurements. Sensors 
can be connected or disconnected at this point and the 
screen should update accordingly.

To store, or log, the measurements over a period of time, 
click the Green start button. A graph should now be drawn 
showing the measurements from all connected sensors. To 
stop logging, simply click on the Red stop button.

At any point during logging or after 
logging the data can be analysed with 
cursor tools from the Tools menu.

Results can be saved with the usual file 
Save option, or exported to other 
applications, such as a spreadsheet.

Some menu options and some display features may not be available depending on the 
current Level.
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 8 Activity Selection Screen
There are two main displays in SensorLab. The first is the Activity Selection screen, which is shown 
when the software starts or when New is selected. The second is the logging and analysis screen, 
which includes a graph of the current data.

The Activity Selection screen shows the currently connected data logger (or interface) and sensors, 
and allows selection of the required activity.

Measurements from the currently connected sensors are shown as gauges and values. This is as far as 
you need go if you only want to use the system as simple meter. Data logging can be started with the 
green button or one of the logging type buttons.

 8.1 Worksheets
A worksheet or a set up template can be selected from the File menu. Worksheets can contain 
instructions for a experiment and can optionally configure SensorLab as required by the experiment. 
Note, templates are only available in SensorLab Plus.
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 8.2 Sidebar Icons (Activity Selection Screen)
The Sidebar contains just a few icons, but these are all that is needed for basic measuring and logging.

The sidebar icons on the activity selection screen are these:

Start data logging.
This is equivalent to the green button on LogIT data loggers and starts AutoLog, 
which logs data without any setting up until the stopped with the red button.

Stop measuring from sensors.
This is equivalent to the red button on LogIT data loggers and stops the current 
activity, in this case it stops measuring and allows sensors to return to standby.

Open an existing SensorLab data file.
A normal file open dialogue is displayed enabling selection of a data file to open. 
Some example data files are supplied with SensorLab.

Fetch data file from logger.
Some data logging systems are able to collect data without being connected to a 
computer. These data files can be transferred to the computer using 'Fetch'.

 8.3 Logging Types
Simple logging using just the Green start button and the Red stop button is called AutoLog. This type 
of logging requires no setting up. It simply logs for as long as you leave it running. The logging rate 
adjusts automatically as the experiment progresses. 

Other logging types can be selected from icons on the right hand side of the screen:

AutoLog can also be started with the Start button.

An alternative logging type is Snapshot. Snapshot logging stores one reading each 
time the Green button is pressed.

Some data logging hardware can collect data rapidly and display it like an 
Oscilloscope.

Set up allows more advanced options to be specified. These include setting various 
timing measurements, such as acceleration.

An alternative to selecting the measurement type is to open a Worksheet file or a Template file, which 
can set any required options.

SensorLab User Guide 8 April 2011 Page 16



 8.4 Logger and Sensor
The currently connected data logger (or interface) and sensors are indicated by icons, as illustrated 
below.

The icon on the left is the data logger or interface. Sensors are generally connected to a computer via 
an interface of some kind. This icon is labelled with the interface model name and also, where 
appropriate, its security stamp. Some devices can be given a unique name to identify it. This is called a 
security stamp.

A battery icon is shown when appropriate. Data loggers generally have a battery to 
power them when not connected to a computer. The state of this battery is 
indicated by the level of the green area of the icon. Some systems show a 'flash' 
icon when being powered externally, by USB, mains adapter or charger.

Technical Note
Strictly speaking a device which can collect and store data independently of a computer is called a 
data logger, while a device which can only collect data when connected to a computer is only an 
interface. In the case of an interface it is the computer which is logging the data, the interface is only a 
means of obtaining measurements.

 8.5 Scale Options
Some sensors offer a choice scales or are 
able to measure a range of different 
properties. 

These options are presented in a menu, as 
illustrated to the right.

Click on the arrow to the right of the 
sensor icon to display the menu. 
Alternatively click on the sensor icon or 
gauge with the secondary mouse button (or 
equivalent).

Sensors can be disabled if not required. 
This is particularly helpful when a data 
logger has built in sensors which are not 
needed. A sensor can also be disabled by 
clicking on the sensor icon or gauge with 
the primary mouse button. The disabled 
status can be toggled on and off.
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When available a list of scale options and measurement types is shown, with the current selection 
indicated with a tick (or similar symbol).

The menu also includes items to enable the scale to be edited. These options are described in detail in 
the reference section of this guide.

 8.6 Level and Help
The bottom right of the screen contains icons for selecting user level and for obtaining help.

Level of sophistication.
Level 1 is the least sophisticated and level 4 is the most sophisticated.
Click on the icon to cycle through the levels.

Help.
The help system window opens showing the contents page.

 8.7 Toolbar
The optional toolbar, displayed at the top of the SensorLab window, contains icons which are 
essentially shortcuts for menu items. These are described in the Reference section of this guide.
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 9 Graph Screen
The graph screen displays data during logging and during analysis.

Gauges to the right of the graph are optional. These show either the current measurements during 
logging or the analysis tool readings when an analysis tool is in use.

The main display area can either contain the graph only or it can be split to show the graph, plus either 
a table or large digits.

Measurement or analysis tool values are shown in the channel information boxes to the right. A 
channel can contain elapsed time, reading numbers, sensor measurements, values typed in (manual 
data channels) or values calculated with a formula entered or a pre-defined function.
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 9.1 Sidebar Icons (Graph Screen)
The Sidebar contains just a few icons, but these are all that is needed for basic measuring and logging.

The sidebar icons on the graph screen are these:

During data logging this button either marks an event or stores data.
Mark – places a small arrow at the top of the graph to mark an event.
Store – stores the readings in snapshot mode or the trace in oscilloscope mode.

During data logging this button stops the logging process.
Logging stops and the current data is presented for analysis. 

Save data.
If the experiment has not already been saved, a standard Save As dialogue opens, 
enabling the data to be saved in a named file.

Print graph.
The standard print dialogue is displayed enabling the current graph to be printed.

When analysing data, after logging has finished, the green button enables logging to be started again, 
either by overlaying the existing data or by repeating the experiment without keeping the current data. 
The red button begins a new experiment by returning to the activity selection screen. 

 9.2 Level and Help
The bottom right of the screen contains icons for selecting user level and for obtaining help.

Level of sophistication.
Level 1 is the least sophisticated and level 4 is the most sophisticated.
Click on this icon to cycle through the levels.

Help.
The help system window opens showing the contents page.

 9.3 Toolbar
The optional toolbar, displayed at the top of the SensorLab window, contains icons which are 
essentially shortcuts for menu items. These are described in the Reference section of this guide.
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 10 Oscilloscope
Oscilloscope mode is used to display fast changing signals, such as sound waveforms, in much the 
same way you would with a conventional oscilloscope.

This mode is selected with the oscilloscope icon on the activity selection screen. 
The oscilloscope icon is only available when suitable high speed data logging 
equipment is connected.

During measurement the display is split to show a live trace on the left and a graph on the right, as 
illustrated below. The green button is used to copy the current waveform to the graph. The Plus edition 
of SensorLab allows overlay of multiple waveforms on the graph, while the Standard edition only 
enables a single waveform to be copied to the graph. Data on the graph can be analysed like any other 
data in SensorLab.

Oscilloscopes are generally used to view repeating waveforms, with the trace continually redrawing. 
In order that each new trace starts at the same point in the waveform, a trigger condition is used. 
Without this trigger system each waveform would start at a random point and the display would be of 
much less use.

SensorLab's oscilloscope uses an automatic trigger. When the input signal meets the required trigger 
condition a display trace begins. When the trigger is met the trigger indicator turns green and when not 
met the indicator turns red. When the trigger condition is not met the display does not update. 

The trigger condition is the input signal rising rising up through the half way point. 
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Oscilloscope's normally have controls to set the vertical and horizontal display resolutions. These are 
usually called Volt per division and Time per division. A division being the grid shown on the 
oscilloscope's display. SensorLab has similar settings available from drop down lists just above the 
oscilloscope display.

When the stop button is pressed the oscilloscope display is removed, leaving the stored data trace(s) 
shown on the graph. This data can be analysed and saved just like any other SensorLab data.

If the signal being monitored does not repeat, it is generally better to use the “Fast with trigger” mode, 
available from the set up wizard. This mode also has the benefit of capturing some measurements just 
prior to the trigger, which helps ensure the very beginning of the event is not missed.
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 11 Set Up Wizard
The set up wizard enables logging types and parameters to be specified. This includes being able to 
select the logging duration and sample interval, and to specify a range of timing based measurements, 
such as velocity and acceleration.

The wizard is available from the Set Up icon on the activity selection screen and 
from the logging menu.

A wizard is essential a set of questions which guide the user through the options available. The 
questions are laid out on pages, with later pages being organised according to earlier answers.

The first page presented is the selection of the logging type, as illustrated below.

Periodic logging is where measurements are stored at regular time intervals. Following this selection a 
page is presented where the experiment duration and sample interval are set. The advanced option also 
enables the number of readings to be set.

The Fast with trigger option is designed to capture relatively rapid events, where such as a magnet 
falling through a coil of wire. Logging starts when the sensor detects a suitable change, avoiding the 
need to start logging at just the right time. To ensure the very beginning of the event is not missed, 
some measurements are stored just prior to the trigger. This is called pre-trigger logging. Following 
this selection a page is presented where the experiment duration and sample interval are set.

The Timing option allows logging of timing based measurements, such as velocity and acceleration. 
Further pages enable setting the shape and size of the object, the organisation and spacing of the 
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sensors, and the mass of the objects. Only relevant pages are shown. Timing options are described in 
detail in the section “Timing Explained”.

It is not necessary to complete all pages, as there is a Start button on each page. This causes the 
experiment to start with options on later pages unchanged from their previous state. This can save time 
when making minor changes to a previous run of the experiment.

The Set Up Wizard is described in more detail in the reference section of this guide.
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 12 Analysis
Data can be analysed during and after logging. The graph can be zoomed and scaled to show the 
traces more clearly. Visual analysis tools can be used on the graph to make measurements from the 
traces displayed. In addition derived data can be calculated from a formula and from pre-defined 
functions.

 12.1 Zoom and Scale
The graph can be zoomed and scaled as required. 

Simple zoom in and out is available with the Auto Zoom and Default Zoom options. These are 
available from the graph menu and from these toolbar icons:

Auto Zoom – Zoom in so that traces fill the graph.

Default Zoom – Zoom out to default scale limits for each channel.

Auto Zoom is also available by double clicking in the graph area. Double click again to perform a 
Default Zoom.

To zoom into an area of the graph, click and drag a box around an area of interest, as illustrated below.

When the mouse button is released the graph is redrawn to display the area selected.

 12.2 Analysis Tools
Visual tools are selected from the Tools menu. The currently selected tool is drawn on the graph, as a 
cross hair cursor or vertical line cursor, by clicking at the desired location. The cursor then follows the 
mouse pointer until the graph is clicked again, at which point the cursor is removed.

Whilst the cursor is shown the gauges (if shown) generally indicate the readings at the cursor position 
and the channel information boxes and large digits (if shown) show the measurements being made 
with the cursor. The channel units are those of the measurement being made, such that the units of 
gradient might be “°C/s” and the units of area might be “°C.s”.
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 12.2.1 Position Tool
The position tool draws cross hair lines on the graph. The cross hair follows the mouse pointer and the 
display shows the values of the cross hair position. This provides a simple point and measure facility.

 12.2.2 Reading Tool
A single vertical cursor line follows the mouse pointer. The values shown are those for each channel at 
the time index indicated by the cursor position. This tool is only available when the X axis is time.
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 12.2.3 Change Tool
The initial position is indicated by a dash cursor line. A second cursor line follows the mouse pointer. 
The values shown for each channel are the difference between the readings at the two time indexes 
indicated by the cursors. This tool is only available when the X axis is time.

 12.2.4 Difference Tool
The initial position is indicated by dashed cross hair lines. A second cross hair follows the mouse 
pointer. The values shown for each channel are the difference in position between the two cross hairs. 
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 12.2.5 Gradient Tool
A single vertical cursor line follows the mouse pointer. The values shown are those for the gradient of 
each channel at the time index indicated by the cursor position. This tool is only available when the X 
axis is time.

 12.2.6 Area Tool
The initial position is indicated by a dash cursor line. A second cursor line follows the mouse pointer. 
The values shown for each channel are the area under the trace between the cursors. This tool is only 
available when the X axis is time.
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 12.3 Derived Data
Derived data can be calculated from a formula and from pre-defined functions.

 12.3.1 Functions
A number of pre-defined functions are available:

● Best straight line fit
● Differentiate (gradient)
● Integrate (area)
● Difference (a – b)
● Product (a * b)

These functions are selected from the Functions dialogue, available in the data menu.

When a function is applied a data channel is created and filled with the results calculated with the 
selected function.

Some functions require two channels to be selected. When one of these functions is selected a second 
channel list is added to the dialogue, as illustrated below.
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 12.3.2 Formula
This is similar to the Function feature, but here the formula is entered with a calculator style keypad. A 
simple formula might be "Temperature + 20". The formula can be applied to existing data during 
analysis or to real time data during logging. The formula can also include references to sensor readings 
and elapsed time. 

Calculate is available from the Data menu (SensorLab Plus only).

To create a new channel which contains a formula or to edit an existing formula, select Calculate from 
the Data menu.

If a new channel is being created, a Channel Details dialogue is presented. Enter here the new 
channel's details, such as Name and Units, then press OK.

The Calculate dialogue is then presented.

Click the calculator style buttons to enter the required formula. When a reference is required to an 
existing data channel, select it from the list on the left.
For example, to create the formula "Temperature + 20", click on the following items:

• Temperature (as shown in the panel on the left) 
• '+' button 
• '2' button 
• '0' button 
• 'OK' button

Note: this example assumes you have a temperature sensor connected and it has been identified in the 
Activity screen. If not it will not appear in the channel list.
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Upon completion of the formula the new data channel should appear and the calculated data shown. 

To edit an existing formula, select Calculate from the Data menu. Use the Delete button to delete 
items from the existing formula and the other buttons to enter new items.

SensorLab User Guide 8 April 2011 Page 31



 13 Worksheets and Templates
Template files are only available in SensorLab Plus edition, while Worksheets are available in both 
editions.

Worksheet and template files can be opened from the File menu. Use the Worksheets item or the 
Templates item, not the Open item. These items may not be shown in the menu when the software is 
set to a low level of sophistication. The Templates item will not be shown in SensorLab standard 
edition.

A worksheet generally contains instructions and other information about an experiment to be carried 
out. The worksheet can be of any file type the computer can display and will be opened in a separate 
window to the SensorLab program. A worksheet could be a word processor document or a web page 
or almost anything else. If an associated template file is available it will be used to set up SensorLab. 
Typically this will result in SensorLab being ready to measure and log data in the way described in the 
worksheet file.

A template file contains settings and optional data. The settings information is used to configure 
SensorLab ready to begin logging. This makes repeating a previous experiment very easy.

When opening a worksheet file or a template file, the default locations offered are the folders 
“SensorLab Worksheets” and “SensorLab Templates” respectively. Both of these are in the SensorLab 
installation folder. Both these file types can however be stored anywhere, with normal file browsing 
available to locate them. 

 13.1 Creating Worksheet Files
Worksheet files can be created with any software, such as a word processor. When selected from 
SensorLab, worksheet files open with the default application for that file type. To create a worksheet 
simply use your preferred application to generate the worksheet, and save it in a convenient location.

To make a worksheet available to all users of the computer, the worksheet needs to be saved in a 
location that everyone can reach, such as a shared folder. To make the worksheet easy to find, it is best 
to save it to the default worksheet folder or a sub-folder of this. The default is “SensorLab 
Worksheets” in the SensorLab installation folder. This will generally require administrator privileges.

 13.2 Creating Template Files
SensorLab Plus edition allows Template files to be created. 

To create a template file which contains all the program settings needed for an experiment and also 
some sample data to overlay:

● Set up the desired experiment from the activity selection screen.
● Start logging and then stop logging when the desired data has been collected.
● Select Template from the File, Export menu. 
● Save the template.

To create a template file which contains all the program settings needed for an experiment, but has no 
data:

● Set up the desired experiment from the activity selection screen.
● Start logging and then stop logging.
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● Select Delete All from the Edit menu, to delete the data logged.
● Select Template from the File, Export menu.
● Save the template.

To make a template available to all users of the computer, the template needs to be saved in a location 
the everyone can reach, such as a shared folder. To make the template easy to find, it is best to save it 
to the default template folder or a sub-folder of this. The default is “SensorLab Templates” in the 
SensorLab installation folder. This will generally require administrator privileges.

 13.3  Associating a Template File
When a worksheet file opens the software looks in the template folder for a template file with a 
matching name. If one is found the software is set up according to the settings in the template file.

Regardless of where the worksheet file is stored, the software only looks in the default template folder 
for a matching template file. So any associated template file must be in this folder. It can not even be 
in a sub-folder of the default templates folder.

The default templates folder is in the SensorLab installation folder and is called “SensorLab 
Templates.”

The default worksheets folder is in the SensorLab installation folder and is called “SensorLab 
Worksheets.”
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 14 Reference – Sidebar Icons
Some sidebar icons are hidden at  lower levels of sophistication.

These icons appear at the left of the screen:

Go button.
Used to start logging, to mark an event and to store readings.

Cancel button.
Used to stop logging, to select a new activity and to quit to program.

Open existing data file.

Save current data to file.

Print current graph.

Fetch file from data logger.

These icons appear at the right of the activity selection screen:

AutoLog.

Snapshot logging.

Oscilloscope.

Set up logging.

These icons appear at the bottom right of the screen:

Level of sophistication.
Level 1 is the least sophisticated and level 4 is the most sophisticated.

Help.

SensorLab User Guide 8 April 2011 Page 34



 15 Reference - Toolbar Icons
Some toolbar icons are hidden at  lower levels of sophistication. Also some features are only available 
in the Plus edition of SensorLab.

These icons appear at the top of the screen when the toolbar is enabled:

Show gauges next to the graph.

Show table below the graph.

Show large digits below the graph.

Show experiment notes.

Show experiment information and statistics.

Zoom In so that the traces fill the graph area.

Zoom Out so that the default scale limits are shown on the graph.

Annotate the graph.

Copy graph image to the clipboard so that it can be pasted into other software.

Copy table values to the clipboard so that it can be pasted into other software.

Delete last measurement stored.
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 16 Reference – Keyboard and Mouse
This section contains details of keyboard shortcuts and mouse actions.

Some features are hidden at lower levels of sophistication. Also some features are only available in the 
Plus edition of SensorLab.

 16.1 Keyboard Shortcuts
In addition to using the mouse to make selections from the Toolbar and menus, you can also use 
keyboard shortcuts to quickly access some features.. 
  
Some menu items have an associated shortcut key or key combination, shown to the right of the menu 
item. For example, Save has the shortcut Ctrl+S, enabling you to save the current experiment by 
pressing the Ctrl (control) key and holding it whilst pressing the S key. There is also a further set of 
shortcut keys that are not show on the menu. 
  
A full list of all shortcut keys is given below:
  

A Auto zoom (graph)
D Default zoom (graph)
G Toggle grid on/off (graph)

 H Toggle heavy display mode on/off (graph)
I View information
L Start logging
M Place marker (while logging data)
N View experiment notes (from graph)
O Overlay existing data
P Stop logging (from graph)
R Repeat logging (from graph)
S Store reading (while Snapshot logging)
T Toggle table on/off (from graph)

  
= (+) Auto zoom (from graph or meter)
_  (-) Default zoom (from graph or meter)

  
Ctrl+I Display experiment information
Ctrl+N New activity
Ctrl+O Open existing experiment 
Ctrl+P Print graph
Ctrl+S Save (with current name)
Ctrl+T View table

  
F1 Display help
F2 Display experiment notes
F3 Toggle graph's grid on/off
F4 Toggle graph's lines on/off
F5 Toggle graph's points on/off
F6 AutoZoom (graph)
F7 Default zoom (graph)
F8 Mark event during logging
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F9 Store reading (while Snapshot logging)
F11 Start logging
F12 Stop logging

  
Del Delete last record stored
Shift+Del Delete all data stored

 16.2 Mouse Actions
In addition to clicking on menu items and toolbar icons, there are a number of mouse actions which 
can be used within this software. 

Context menus are available for many display features. These menus provide options which are 
relevant to the item pointed to at the time. Where a second mouse button is available, which is 
standard on a PC, the second button is used to select the context menu. Where only a single button is 
available a key press is usually required to select the context menu.

 16.2.1 Activity Screen
The Activity Screen is shown when the software starts and when New is selected. 

● Click on a sensor icon or gauge to toggle the sensor on/off. This can be used to disable a 
logger's internal sensor when it is not required for an experiment.

A context menu is also available for the sensor icons and gauges. This provides options for each 
sensor, including the choice of measurement types and scales.

 16.2.2 Graph
The following mouse actions apply when clicking and dragging in the graph area.

● Single click on the graph to display the current analysis tool. Click again to remove the tool.

● Drag the mouse pointer in the graph area to frame an area for zooming in.

● Double click on the graph to toggle the display between AutoZoom and default zoom.

● Single click on the channel information boxes (at the right of the graph) to edit channel 
details, including the numeric value of manual data channels.

● Single click just above the graph to edit the title.

● Single click to the left, right and below the graph to select the graph axis channels.

A context menu is also available in the graph area.

 16.2.3 Table
The area below the graph can be used to display a data table.

● Single click a column heading to edit the channel's details.

● Double click in the column of a manual data channel to select the cell for editing. This enables 
the existing numeric value to be edited or entered.
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A context menu is also available in the column heading area. 

The context menu includes the option “Add Channel”. This adds a data channel, which is shown as a 
column in the table. The channel contains 'manually entered data' which can be typed into the table as 
required. This is useful for entering data which can not be easily measured with a sensor, such as the 
distance up a ramp.

 16.2.4 Digits
The area below the graph can be used to display values as large digits. 

● Click on one of the displayed values to edit that channel's details. 

A context menu is also available in the digits area.
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 17 Reference – Menus
This section contains a feature by feature reference in alphabetical order for the program's menus.

Some menu items are hidden at lower levels of sophistication. Also some menu items are only 
available in the Plus edition of SensorLab.

 17.1 Administrator Sub-menu
The Administrator Menu is an item in the File Menu. Most of the items in this menu are only available 
when Manager mode is enabled. To enable Manager mode, press the key combination Shift/Ctrl/Alt/T 
and tick the Manager mode option.

Set Logger's Clock
Some data loggers have an internal clock which provides time and date information for logged data. 
This option allows the logger's clock to be set to the same time as the computer's clock. This feature is 
not required very often as the software checks the logger's clock looks sensible each time it is 
connected, and updates it if it looks wildly wrong.

Set Logger's Security Stamp
Some data loggers have a customisable message which is displayed when the logger is turned on. This 
message can be used for any purpose, such as identify the owner or the logger number in a set.

Reload Logger's System Software 
Some data loggers have built in software which can be reloaded if there is a problem, or updated to 
add new features or sensor support. Reloading the logger's software can cause data files in the logger's 
memory to be deleted, so it is recommended that these be fetched and saved first. Reloading can take a 
few minutes.

Software Activation
SensorLab runs in a function limited evaluation mode until activated. Activation involves entering an 
activation code. Consult the licence document, supplied with SensorLab, for details of the activation 
code. The activation code determines which features (Standard or Plus) are enabled, which data 
loggers are supported and also the licence type (single user or site).

Administrator's Settings
Administrator settings allows defaults values to be set for things like file location, sophistication level 
and serial ports. These are usually the settings which apply to all users of SensorLab. If the option 
“Allow users to save options” is enabled, then individual users can set their own start up options, 
overriding the defaults set with these administrator settings. The user options feature is available from 
the Tools menu.

 17.2 Colour Sub-menu
The Colour Menu is an item in the View Menu.

Standard
This colour scheme uses shades of the initial channel colour when overlaying data from the same 
sensor. This maintains the link between channel colours on the computer screen and those indicated on 
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some data logging systems. The disadvantage is that it is not as easy to distinguish overlay channels 
from each other.

High Contrast
The High Contrast option breaks the colour association in the interest of providing more easily 
distinguishable colours.

 17.3 Data Menu
This menu provides features associated with a specified data channel. It is also available as a context 
menu when right clicking on a channel information box, at the right of the graph.

Edit Details
Channel details, such as name, colour and decimal places, can be edited with this feature. For manual 
data channels the current numeric value can be entered here. A manual channel is one created with 
“Add channel” and is used to type in values instead of using a sensor.

Smooth
Values in a channel are smoothed to reduce noise and other undesirable spikes. The Standard edition 
applies a simple fixed smooth, while the Plus edition offers a variable degree of smoothing.

Tare to
This enables a channel to be adjusted from its current value to the new value entered. Every value in 
the data channel has an appropriate offset added or subtracted. This can be used to provide a single 
point calibration, such as adjusting pH readings to match a buffer solution.

Unit Conversions
Some measurements have common alternative units which might be more suitable in some 
applications. A typical example is millivolts and volts. This feature offers a simple means of 
converting data from one unit to another, using pre-defined conversion functions. There is also a 
facility to specify simple conversion functions which are not pre-defined.

Custom Scales
Custom scales allow new scales to be defined based on two known values. This can be used to provide 
a two point calibration facility.

Invert Values
All values in the specified channel are inverted. Positive numbers become negative and ngative 
numbers become positive. For example, 20 volts becomes -20 volts.

Add Channel
A new channel is created for values to be typed in. This is typically used to provide values for which a 
sensor is not available. For example, when experimenting with the speed of a trolley when released 
from different distances up the ramp, the distance can be entered manually whist the speed can be 
measured with a light gate.

Duplicate Channel
The selected channel is duplicated. The new copy contains the same data as the original, but its name 
is preceded with an ampersand to indicate that it is not original data. The duplicate channel has the 
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same status as a channel created with the Add Channel feature, and its data values can be edited in the 
table. Duplicating channels can be useful as it allows original data to be compared with smoothed 
versions or when experimenting with editing data values.

Function Plot
A new data channel is created and is filled with data values calculated using one of the pre-defined 
functions. Functions include Bast straight line fit, differentiate, integrate, difference and product.

Calculate 
A new data channel is created and is filled with data calculated with a formula entered using a 
calculator style keypad. Calculations can be applied before, during and after logging. Calculating data 
before and during logging allows real time derived data to be shown.

Delete Channel
The selected data channel is deleted and all its data discarded. This is particularly useful when logging 
multiple runs (overlays) of an experiment and unwanted data sets are no-longer required.

 17.4 Edit Menu
This menu provides standard copy functions and data editing features

Copy Graph
The current graph image is copied to the clipboard. From here is can be pasted into any suitable 
software, such as a word processor or image editor.

Copy Table
The current table values are copied to the clipboard. From here is can be pasted into any suitable 
software, such as a spreadsheet (eg. Excel) or a word processor.

Delete Last
Delete the last stored data record. This is particularly useful when snapshot logging or timing. If the 
last result stored is not wanted for any reason it can be deleted.  For example, if making a timing 
measurement and the light gate is accidentally blocked, the resulting invalid measurement can be 
deleted.

Delete All
This deletes all data values from all channels. This is useful when creating a template file, as these 
often want to be clear of any measurements. This feature can also be used to clear the data before 
repeating an experiment, although this is generally achieved by turning off the overlay option.

Title
The experiment title, which is usually shown above the graph, can be edited using this menu item.

 17.5 Export Sub-menu
The Export Menu is an item in the File Menu. This is primarily to enable data to be saved in a formats 
suitable for use by other software. The data may not be able to be read back into SensorLab, so don't 
forget to also save it using the normal Save option. Some export formats are only really useful on one 
platform, such as Windows.
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Datalogging Insight (SID Format)
Data is saved in a format suitable for importing into the popular Insight range of data logging 
software. This range includes Datalogging Insight, Junior Datalogging Insight and iLog.

InspireData (TEXT Format)
Data from SensorLab can be analysed and presented using InspireData software.

Microsoft Excel (CSV Format)
Use this option to transfer the data into Microsoft's Excel spreadsheet.

OpenOffice.org Calc (CSV Format)
The popular cross-platform office suit, OpenOffice, includes the Calc spreadsheet which can open 
files created with this option.

Software Independent Data (SID)
This format is supported by many data logging and analysis program. It was designed by a group of 
developers, including ourselves, specifically to share measurement data. The format is documented in 
the 1992 NCET publication: ISBN 1 85379 221 7, “Resources for data monitoring and control for 
science education”. 

Comma Separated Values (CSV)
The CSV format is a very common file format supported by most programs which handle tabular 
numeric data. This file is essentially a simple text file with the channel names of the top following by 
numeric data stored one record on each line. Each item on a line is separated with a comma. A CSV 
file produced by SensorLab stores the numeric values organised in the same way as they are shown in 
SensorLab's table. Typically therefore the file contains:

“Elapsed time”,”Channel 1 name”,”Channel 2 name”
“Elapsed time units”,”Channel 1 units”,”Channel 2 units”
<Elapsed time for first reading>,<Channel 1 first reading>,<Channel 2 first reading>
<Elapsed time for second reading>,<Channel 1 second reading>,<Channel 2 second reading>
etc.

Tab Separated Values (TSV)
This format is very similar to CSV, except there is a TAB character between each item instead of a 
comma. Like CSV the channel names are in quotes.

Text (TXT)
This is a standard text file, with the text file extension. It is similar to TSV, but the channel names are 
not in quotes. This is generally the best format to use when exporting data to programs designed to 
handle simple text.

Template
A template is a SensorLab file which contains settings and optional data. This can be used as a quick 
way to set up SensorLab when repeating an experiment at a later date. It is also possible to associate a 
template file with a worksheet file, so that opening a worksheet file also opens its matching template 
file and thus sets SensorLab ready for logging.
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 17.6 File Menu
The file menu contains the usual Open, Save and Print options, plus a few SensorLab specific items, 
such as worksheets.

New
New returns the software to the activity selection screen ready to begin a new data logging session.

Open
An existing SensorLab data file is selected and opened. SensorLab data files have the extension SLD.

Save
Data is stored in the current SensorLab data file, replacing the previous version.

Save As
A SensorLab data file name is selected and the current data is stored in that file.

Worksheet
A worksheet file is selected and opened in a new window. A worksheet generally contains instructions 
and other information about an experiment to be carried out. The worksheet can be of any file type the 
computer can display. It could therefore be a word processor document or a web page. If an associated 
template file is available it will be used to set up SensorLab. Typically this will result in SensorLab 
being ready to measure and log data in the way described in the worksheet file.

Template
A template file is selected and opened. A template file contains settings and optional data. The settings 
information is used to configure SensorLab ready to begin logging. This makes repeating a previous 
experiment very easy.

Fetch From Logger
Some data logging equipment is able to collect data without being connected to a computer. It can 
later be connected and the Fetch option used to ready the data from the device.

Import
Any file which SensorLab can read can be selected and opened. This includes LogIT Lab data files 
and Software Independent Data files. Imported data is not generally overwritten when Save is selected, 
but instead a SensorLab data file is created.

Export
The Export sub-menu is opened. This menu is primarily to enable data to be saved in a formats 
suitable for use by other software. The data may not be able to be read back into SensorLab, so don't 
forget to also save it using the normal Save option. Some export formats are only really useful on one 
platform, such as Windows.

Page Setup
A page set up dialogue is shown. Typically this enables page size and orientation to be set ready for 
printing.
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Page Margins
A page margins dialogue is shown (Mac OS X version only). This enables the printer page margins to 
be set.

Print Preview
A print preview is shown. This shows the graph as it will appear if printed.

Print
The print dialogue is shown. From here the graph can be printed.

Administrator 
The Administrator sub-menu is opened. Most of the items in this menu are only available when 
Manager mode is enabled. To enable Manager mode, press the key combination Shift/Ctrl/Alt/T and 
tick the Manager mode option.

Exit (or Quit)
SensorLab terminates.

Recent File List
A list of recently opened data files is shown at the bottom of the File menu on some platforms.

 17.7 Graph Menu
This Graph menu contains options which determine what is shown on the graph and how it appears.

Font
The font selection dialogue is shown, allowing selection of the font used for the graph.

Annotate
The graph can be annotated with labels. A label is typed in and dragged to any point on the graph.

Auto Zoom
The graph scales are zoomed so that the traces fill the graph. This is a quick and simple way to zoom 
in to small variation on the graph traces.

Default Zoom
Graph scales are zoomed out to their default limits. The default limits usually show the full range of 
the sensor.

X Axis Scale
The graph's X axis can be selected from all available channels. Usually the X axis is elapsed time, but 
options are available to show the actual time and date, as well as other data channels. By selecting a 
sensor channel the graph shows one sensor plotted against another.

Y Axis Scale (Left)
The graph's Y axis can be selected from all available data channels except elapsed time. This axis is 
shown to the left of the graph.
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Y Axis Scale (Right)
As well as a scale on the left of the graph, a scale can also be selected to be shown on the right of the 
graph.

Grid
The graph can be drawn with an optional grid. This menu item toggles the grid on and off. The grid is 
aligned to major scale divisions.

Lines
Individual data points can optionally be joined with lines. This menu item toggles the lines on and off. 
A graph with lines between the points is often called a line graph.

Points
Small crosses can be drawn at each individual data point on the graph. A graph with just points and no 
lines between is often called a scatter graph.

Bars
Instead of showing a scatter graph or a line graph, it can be shown as a bar graph. A vertical bar is 
drawn from each data point to the X axis. If there are many data points the area under the graph 
becomes a solid coloured area.

Heavy
The graph can be toggled between normal and heavy format. The heavy format uses a large bold font 
and draws the graph with thick lines. This makes the graph easier to see from a distance.

Best Line Fit
This option toggles on and off the display of best straight line fits. These are shown as straight lines 
calculated to be the best fit to the data points shown. The line fit formula is also shown on the graph.

 17.8 Help Menu
The help menu provides access to the program's help system and also to on-line resources.

Introduction
The introduction page of the help system is displayed.

Contents
The help system's contents page is shown.

LogIT World
Unless blocked by security software, a browser window opens showing the LogIT World website.

Evaluate SensorLab Plus 
Toggle between SensorLab Standard edition and evaluation mode for SensorLab Plus edition.

Technical Support
A small window opens giving information about the technical support website.
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About SensorLab
A small window opens giving information about this version of SensorLab.

 17.9 Logging Menu
This menu has options relating to data logging and feedback control.

Start
This item starts data logging. In overlay mode, new data is added to any existing data sets, otherwise 
the new data replaces any existing data.

Stop
Available only during data logging, this item stops data logging.

Mark
During some types of data logging this item enables a marker to be places. A mark is shown as a small 
arrow at the top of the graph.

Store
During snapshot logging, this item stores the current readings. During oscilloscope mode the current 
oscilloscope trace is copied to the graph. The Standard edition of SensorLab only allows one 
oscilloscope trace to be copied to the graph, while the Plus edition allows overlaying of traces.

Overlaying
The overlay option can be toggled on and off. When overlay is selected, the start button causes a new 
set of data to be logged and added to any existing data sets. When not selected, the new data replaces 
any existing data.

Control
As well as measuring and logging the results, decisions can be made and outputs turned on and off. 
This enables simple applications such as temperature control to be implemented. This option requires 
suitable output devices to be connected. Some data logging systems allow output devices, such as 
relays, to be connected to 'sensor' sockets, while others use special units, such as SwitchIT.

Set Up
The set up wizard is opened allowing measuring and data logging to be configured. Options include 
selecting the logging interval, the logging duration and also a wide range of timing based 
measurements. When selecting this item from the graph screen the current data logging settings can be 
modified before re-running an experiment.

 17.10 Tools Menu
The tools menu offers a range of visual analysis tools, such as area and gradient. To use the selected 
analysis tool just click on the graph. An analysis cursor then follows the mouse pointer and 
measurements are displayed. Click again to remove the cursor.

Position
The position tool draws cross hair lines on the graph. The cross hair follows the mouse pointer and the 
display shows the values of the cross hair position. This provides a simple point and measure facility.
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Reading
A single vertical cursor line follows the mouse pointer. The values shown are those for each channel at 
the time index indicated by the cursor position. This tool is only available when the X axis is time.

Change
The initial position is indicated by a dash cursor line. A second cursor line follows the mouse pointer. 
The values shown for each channel are the difference between the readings at the two time indexes 
indicated by the cursors. This tool is only available when the X axis is time.

Difference
The initial position is indicated by dashed cross hair lines. A second cross hair follows the mouse 
pointer. The values shown for each channel are the difference in position between the two cross hairs. 

Gradient 
A single vertical cursor line follows the mouse pointer. The values shown are those for the gradient of 
each channel at the time index indicated by the cursor position. This tool is only available when the X 
axis is time.

Area
The initial position is indicated by a dash cursor line. A second cursor line follows the mouse pointer. 
The values shown for each channel are the area under the trace between the cursors. This tool is only 
available when the X axis is time.

Options
The options dialogue is shown, enabling the user to make changes to the sophistication level, data 
logger connections and file locations. If enabled by the administrator these options can be saved for 
the next time the program is used..

 17.11 View Menu
The view menu provides options which control what is shown on the screen. It also allows display of 
notes and information windows.

Title
The graph title can be toggled on and off. The title is displayed above the graph.

Gauge
Gauges can be shown to the right of the graph. These are toggled on and off with the gauge item.

Table
A table of results can be shown below the graph. The table can be toggled off so that a larger graph 
can be shown.

Digits
With this option selected the area under the graph is used to show measurements as large digits. As 
with the table option, digits can be removed to show a larger graph. 
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Time And Date
The time and date option can be toggled on and off. When turned on the table includes a column 
showing the actual time and date of each reading. Also a time and date information box is added to the 
display at the right of the graph.

Toolbar
The toolbar, show above the graph, can be toggled on and off.

Notes
This item displays the experiment notes window. This window enables nots to be typed in to 
accompany the experiment results.

Information
The information window shows details and statistics for the current data.

Colour
The Colour sub-menu is opened. This provides a choice of colour schemes.
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 18 Reference – Dialogues
This section contains a feature by feature reference in alphabetical order for the program's dialogue 
boxes.

Some features described here are hidden at lower levels of sophistication. Also some features are only 
available in the Plus edition of SensorLab.

 18.1 Administrator's Settings
Administrator Settings are designed to allow the system administrator to make settings which apply as 
the defaults for all users of the software. 

Administrator Settings are shown by pressing the key combination Shift/Ctrl/Alt/T. In Manager mode 
these settings are also available from the File, Administrator menu.

The Sophistication Level options determine which features are available to the user and the  initial 
presentation style. 

The Level is set from 1 to 4, with 4 being the most sophisticated.

Manager mode enables some menu items to be shown or hidden.  These items, shown in the 
Administrator menu, are:

● Set Logger's Security Stamp
● Reload Logger's System Software
● Software Activation
● Administrator's Settings

To hide these items, clear the Manager Mode tick box and select Save.

When “Allow users to save options” is selected, individual users can save their own personal 
preferences with the Options dialogue from the Tools menu, thus overriding the defaults set here.
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The File location is the initial place offered when opening and saving data files.

Serial and Bluetooth ports used to connect to a data logger can also be set where appropriate. The 
Windows version supports 'COM' ports for both serial and bluetooth connections. The Mac OS X 
version supports legacy serial ports (although these have not been available on Mac computers for a 
long while) and supports 'standard' bluetooth configuration (not using serial port emulation). The 
Linux version supports TTY devices for serial and RFCOMM devices for bluetooth. For more 
information on bluetooth see the Bluetooth section of this guide.

When saving these settings the software may display a confirmation of where the settings have been 
stored or it may display instructions on how to store these settings for all users of the computer. Some 
operating systems have security which prevents an application from storing such settings in a location 
which is available to other users. In some cases being logged on as an Administrator will allow this, in 
others it is necessary to provide a suitable password to enable the operation and in others it is 
necessary to copy settings manually.

 18.2 Calculate
The Calculate feature enables a data channel to be calculated using a formula. The formula can include 
references to sensor readings and elapsed time. A simple formula might be “Temperature + 20”. The 
formula can be applied to existing data during analysis or to real time data during logging.

Calculate is available from the Data menu (SensorLab Plus only).

To create a new channel which contains a formula or to edit an existing formula, select Calculate from 
the Data menu.

If a new channel is being created, a Channel Details dialogue is presented. Enter here the new 
channel's details, such as Name and Units, then press OK.
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The Calculate dialogue is then presented, as illustrated below.

Click the calculator style buttons to enter the required formula. When a reference is required to an 
existing data channel, select it from the list on the left.

For example, to create the formula “Temperature + 20”, click on the following items:
1. Temperature (as shown in the panel on the left)
2. '+' button
3. '2' button
4. '0' button
5. 'OK' button

Note: this example assumes you have a temperature sensor connected and it has been identified in the 
Activity screen. If not it will not appear in the channel list.

Upon completion of the formula the new data channel should appear and the calculated data shown. 

To edit an existing formula, select Calculate from the Data menu. Use the Delete button to delete 
items from the existing formula and the other buttons to enter new items.

 18.3 Channel Details
The Channel Details dialogue is used to enter or edit things like the Name, Units and Decimal places 
of a channel. 

Channel Details is available from the Data menu or by left clicking on the channel information box or 
from the context menu associated with a channel.
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The channel name is that shown in the sensor information box to the right of the graph and as a 
column heading on the table. A typical example is “Temperature”.

The units are the those shown by data values. A typical example is “°C”. It is important to note that 
changing the units here does not alter the data values. Thus changing “°C” to “F” does not alter the 
values to Fahrenheit. The units are just a label. To change the meaning of the data values, use the Unit 
Conversion feature.

The Description is stored for each channel. It is shown in the Information window, but otherwise has 
no functional significance. It can be used to provide more information about a channel. For example, 
with a number of temperature sensors used in cups made of different materials, it might be useful to 
describe these materials here. In such a case the description might be set to “Expensive china cup”.

The number of decimal places shown for the channel can be set from 0 (eg. 12 °C) to 5 (eg. 12.34567 
°C).

The Value or Initial Value is used to set a numeric value for the channel. If the channel contains 
manually entered values, such as distance up a ramp, the Value is that stored when a record is logged. 
If the channel contains a formula the Initial Value is the value used to calculate the first point when the 
formula contains a reference to its own channel.

The Colour used by the specified channel can be set by clicking on the coloured button.

The maximum and minimum values are used as the default limits for the channel. When a graph is 
zoomed out, these are the scale limits shown.

 18.4 Control Output Set Up
As well as measuring and logging, with suitable equipment connected, SensorLab is able to control 
things. For example, it is possible to build a temperature controller by connecting a temperature sensor 
and a heater.
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Control is available from the Logging menu.

The level of control offered is quite simple feedback control. SensorLab does not aim to complete with 
dedicated control systems.

The Control feature  is available from the Logging menu when an output device is connected to a 
sensor socket or a control interface, such as SwitchIT, is connected. 

There are 6 possible outputs. Only those which have been detected in the Activity screen are shown as 
available.

The required control condition is set by making selections from the drop down lists provided and a 
suitable threshold value entered. For example, to set a heater to come on when the temperature is less 
than 20 °C, select “Temperature” from the first list, “is below” from the second list, and enter “20” 
below that. Note, this example assumes a Temperature sensor has been detected.

The Enable box should automatically be ticked when selections are made, but it can be cleared if the 
control function needs to be disabled.

When a control condition has been set and enabled, the output is turned On when the condition is met 
and Off  when not met. This is both during measuring (before logging) and during logging.

 18.5 Custom Scale
The custom scale option enables a conversion to be applied to numeric data values. The conversion is 
specified by providing new values for two points. All other values are calculated by extrapolating from 
these two. 

The Custom Scale dialogue is available from the Data menu or from the context menu associated with 
a channel.
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The practical application of this feature is to provide a two point calibration mechanism. Not all 
measurements are perfect and where a correction is required based on two known values, this features 
should be used.

The channel to be customised is set  using the channel drop down list.

A new Name can be specified for the channel. Similarly a new Units label can be entered. It is 
important to note that changing the units here does not alter the data values. This is just a label.

The pair of data values are called Point 1 and Point 2. Initially these contain the maximum and 
minimum limits of the channel, with the “becomes” value being the same as the original. At this point 
the data values will not be changed, as there is no difference in the “becomes” values.

To specify a new values for the current maximum and minimum values shown, enter the new values in 
both of the “becomes” boxes. Alternative alter the original values as well.

Home made sensor example
Lets say you have designed a system for measuring the volume of water in a water tank. The output of 
this device gives a voltage of 100mV per litre and you have it connected to the logger with a Designer 
Sensor adapter. This adapter normally measures 0 to 2.5 volts. 
Suitable entries are:
Name = Water Volume
Units = Litre
Point 1 = 0 V becomes 0 Litre
Point 2 = 0.1 V becomes 1 Litre

Two point calibration example
If you want to perform really accurate pH measurements you would normally use a buffer solution and 
adjust the probe or use the software's Tare facility. This would fine tune the reading at one known 
point. In extreme cases you may wish to correct an error in the 'slope' response of a probe. Here two 
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point adjustment is required. In the case of pH you might use two buffer solutions and make two test 
measurements. You may obtain the results:
Buffer solution 7, reads 6.9
Buffer solution 10, reads 10.1
To correct this error, enter the calibration points:
Point 1 = 6.9 pH becomes 7.0 pH
Point 2 = 10.1 pH becomes 10.0 pH

 18.6 Delete Channel
Data channels can be deleted.

The Delete Channel dialogue is available from the Data menu and from the context menu associated 
with a channel.

The selected data channel is permanently deleted and its data lost.

 18.7 Duplicate Channel
Channels can be duplicated (copied).

The Duplicate Channel dialogue is available from the Data menu.

A new channel is created which is a copy of the one selected. 

The new copy contains the same data as the original, but its name is preceded with an ampersand to 
indicate that it is not original data.
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The duplicate channel has the same status as a channel created with the Add Channel feature, and its 
data values can be edited in the table. 

Duplicating channels can be useful as it allows original data to be compared with smoothed versions 
or when experimenting with editing data values.

 18.8 Fetch from LogIT
Remote data loggers, such as LogIT Voyager, allow data to be logged when the logger is not 
connected to a computer. This data is stored inside the data logger. The Fetch feature is used to read 
this data and display it.

The fetch dialogue is available from “Fetch from Logger” menu item or from the Fetch icon.

The Fetch dialogue shows all the data files stored in the connected data logger. The most recently 
logged data is shown at the top of the list. The data type and start time and date are shown for each 
file.
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Select a file by double clicking on it or by clicking on it and then click OK.

The data is drawn on the graph as it is read, so it looks similar to real time logging.

 18.9 Function
Pre-defined Functions can be applied to existing data or to data being logged. A new data channel is 
created and filled with values calculated with the selected function.

The Function dialogue is available from the Data menu.

The required function is selected from the first drop down list.

Depending on the function selected, one or two data channels need to be selected for use by the 
function. For example, when plotting the difference between two channels, two must be specified, 
whilst only one is needed to plot a best straight line fit.

The available functions are:
● Best straight line fit
● Differentiate
● Integrate
● Difference (a – b)
● Product (a * b)
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When a function is applied a new data channel is created and is given an appropriate name, units and 
description.

The Name is that of the first source data channel, prefixed with an apostrophe to indicate it is derived 
data.

The Units are set depending on the function used. Where a function is applied to two source channels, 
the units are A-B for difference and A.B for product, where A and B are the source channel units.

 The description is set to indicate the function used. For example, it might say “Difference between 
"A" and "B"”.

 18.10 Graph Annotation
The graph can be annotated with labels, as illustrated below.

Annotate options are available from the Graph menu.

SensorLab User Guide 8 April 2011 Page 58

Graph showing annotations

Annotate (Windows version)



Type the required annotation into the box labelled Annotation.

Select which channel the annotation should be attached to, from the list provided. The annotation will 
be shown in the colour of the selected channel and will be moved with that channel's graph trace.

Click “Place on Graph” to put the label on the graph. The label will follow the mouse pointer until the 
primary mouse button is pressed, whereupon it will be fixed in position.

The Annotation dialogue also includes the buttons “Delete All” and “Delete Last”.  Delete All 
removes all annotations from the graph, while Delete Last removes the last annotation placed on the 
graph.

 18.11 Graph Axis
The Graph's Axes can be selected from a list of suitable channels.

The Graph Axis dialogue is available from the Data menu, from the graph's context menu and from 
clicking around the edge of the graph.

The graph has an X axis, drawn at the bottom of the graph, and a Y axis, drawn to the left of the graph. 
It can also have a second Y axis, drawn to the right of the graph. 

The X axis channel options can include elapsed time, reading number and also time and date. The time 
and date option shows the actual time and date, rather than the elapsed time, but is only available in 
SensorLab Plus.

The Y axis channels are restricted to sensor data, manual data and derived data. Elapsed time, reading 
number and time and date can not be used.

 18.12 Invert Values
All values in a selected channel can be inverted.

The Invert Values dialogue is available from the Data menu.
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All positive values in the selected channel become negative and all negative values become positive. 
For example, 12.34 becomes -12.34 and -100 becomes 100.

This can be useful when using current and voltage sensors which can easily cause confusion over 
polarity. A quick selection of Invert Values will reverse the polarity.

 18.13 Logging Setup Wizard
This Wizard guides the user through the options available when specifying measurement and data 
logging.

The Set Up Wizard is available from the Logging menu and from the Set Up icon on the 
Activity screen.

An alternative to using the set up wizard is to use a Worksheet or Template file which automatically 
configures SensorLab for the required experiment.

Set up options are arranged in a set of pages with Next and Back buttons. Options offered on later 
pages may depend on selections made on earlier pages. 
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 18.13.1 Set Up Wizard – Logging Type
There are three basic logging types: Periodic, Fast with trigger and Timing.

Periodic is where measurements are stored at regular time intervals.

Fast with trigger is for short events, such as a magnet dropping through a coil of wire, where logging 
starts when triggered by the measurements being made. The automatic logging start is required as it is 
difficult to click the start button at just the right time. When logging in this mode data is stored just 
prior to the trigger condition to ensure the start of the event is captured.

Timing is used for any measurements where the time events take is what is required. Data is not stored 
a regular intervals, but instead events are timed and these times, or values calculated from them, are 
stored. This feature is usually used with light gates, which detect objects passing through them. From 
the times measured,SensorLab can calculate Speed, Velocity, Acceleration, Momentum, Kinetic 
Energy and Simple Harmonic Motion Period.

 18.13.2 Set Up Wizard – Periodic Logging
Periodic logging requires the maximum duration of the data logging to be selected from a drop down 
list or set with a slider. The interval between readings being stored is also shown. When Periodic 
logging (advanced) is selected, the number of readings can also be selected. This enables very large 
data sets to be collected when required.
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 18.13.3 Set Up Wizard – Fast with trigger
Fast logging also requires the duration of the data logging to be selected from a drop down list or set 
with a slider. The interval between readings being stored is also shown. The trigger condition is 
automatically set. Some data is collected just prior to the trigger to avoid missing the beginning of the 
event being studied. This is called Pre-trigger logging.

 18.13.4 Set Up Wizard – Timing
Various timing based measurements can be set up. A full explanation is given in the “Timing 
Explained” section at the end of this guide.

First set the measurement required, such as Acceleration. The Manual Calculation options results in 
the raw times being displayed rather than the calculated value, allowing the user to perform the 
calculation themselves.
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Depending on the measurement type and number of suitable sensors available there may then be the 
choice of making the measurement at any sensor, at each sensor or from one sensor to another. The 
distance between the sensors may also be entered.
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Again depending on the measurement type there may be a choice of object shapes. The width of the 
object may also be entered.

Finally, some measurement types require the mass of the object(s) to be entered.
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 18.14 Match Sensors
When opening a template file, or a worksheet with an associated template, the software attempts to 
match the connected sensors to the requirements of the experiment (as defined by the template file). If 
the software has any doubts about the suitability of the connected sensors, the Match Sensors dialogue 
is displayed.

The left side of the dialogue shows the sensors required for the experiment (as defined by the template 
file). The right side shows the current sensors or a green tick if the software considers a sensor to be a 
suitable match.

The dialogue continually checks the connected sensors, so the sensors can be adjusted until a match is 
achieved. 

The OK button can be used to continue the experiment even if the sensors are not shown as matching.

 18.15 Options
This dialogue enables the user to set various options for the rest of the session. The option to save 
these for use next session is available if the administrator sets “Allow users to save options” from the 
Administrator's Settings dialogue.

The Options dialogue is available from the Tools menu.
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The Sophistication Level determines which features are available to the user and the initial 
presentation style. The Level is set from 1 to 4, with 4 being the most sophisticated.
Clicking on the Level icon causes the level to cycle up to the next most sophisticated, or cycle from 
level 4 around to level 1.

The File location is the initial place offered when opening and saving data files.

Serial and Bluetooth ports used to connect to a data logger can also be set where appropriate. The 
Windows version supports 'COM' ports for both serial and bluetooth connections. The Mac OS X 
version supports legacy serial ports (although these have not been available on Mac computers for a 
long while) and supports 'standard' bluetooth configuration (not using serial port emulation). The 
Linux version supports TTY devices for serial and RFCOMM devices for bluetooth. For more 
information on bluetooth see the Bluetooth section of this guide.

 18.16 SensorLab Evaluation
SensorLab runs in Evaluation mode with most loggers and sensors until activated.

Evaluation mode enables the software to be evaluated before purchase. The evaluation version can 
also be downloaded and used to update an earlier installation.

In evaluation mode there are a number of limitations:
● Printouts are defaced
● Logged data can not be saved
● Logging is limited to a maximum of 8 minutes in duration

After activation in Standard mode, it is still possible to evaluate Plus mode. To do this select “Evaluate 
SensorLab Plus” from the Help menu. 

The activation code details can be found on the licence sheet supplied with SensorLab software.

Technical Note:
Activation details are stored in a simple text file. To enable activation for all users of the computer, a 
second copy of this file needs to be stored in a central location. In some cases this is achieved by a 
user with Administrator privileges activating the software, in other cases it is necessary to copy the file 
manually. A prompt is given if this latter method is required. Network administrators may need to 
distribute the file to all their computers. Further details can be found in the separate installation 
document.

 18.17 SensorLab Licence
The Licence dialogue enables SensorLab activation codes to be entered.

This dialogue is available from the File menu, select Administrator, then Software Activation. This 
option is only available in Manager mode.
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The activation code details can be found on the licence sheet supplied with SensorLab software.

Enter a contact name, organisation (eg. School name) and post/zip code. Enter the SensorLab 
activation code and then click Apply. A notification box will indicate the features enabled by that 
code.

Several codes can be entered if required. A typical example is a single user licence code followed by a 
site licence upgrade code. Codes can also be added at a later date. 

When all codes have been entered, click the close button. A notification box may then indicate where 
the licence details have been saved.

Technical Note:
Activation details are stored in a simple text file. To enable activation for all users of the computer, a 
second copy of this file needs to be stored in a central location. In some cases this is achieved by a 
user with Administrator privileges activating the software, in other cases it is necessary to copy the file 
manually. A prompt is given if this latter method is required. Network administrators may need to 
distribute the file to all their computers. Further details can be found in the separate installation 
document.

 18.18 SensorLab Plus Evaluation
After activating SensorLab in Standard edition it is still possible to evaluate the Plus edition.
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To evaluate the Plus edition, select Evaluate SensorLab Plus from the Help menu.

In evaluation mode there are a number of limitations:
● Printouts are defaced
● Logged data can not be saved
● Logging is limited to a maximum of 8 minutes in duration

To switch back to Standard Edition, de-select Evaluate SensorLab Plus in the Help menu.

Returning to Standard Edition causes the program to restart, which will discard any unsaved data.

 18.19 Set Logger's Clock
Remote data loggers, such as LogIT Voyager, have built in clocks. These clocks provide the start time 
and date information for remote data logging.

This dialogue is available from the File menu, select Administrator, then Set Logger's Clock. 
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The data logger's internal clock is set to the same time as the computer's clock.

Generally it is not necessary to set the Logger's clock with this feature, as SensorLab checks the clock 
every time the Logger is connected. If it appears to be wildly wrong it sets the clock automatically.

 18.20 Set Logger's Security Stamp
Some loggers have a security stamp feature, allowing a custom message to be displayed. This might, 
for example, be a name, post code and/or logger number.
  
Security Stamp is available from the File menu, select Administrator, Set Logger's Security Stamp. 
This option is only available in Manager mode.
  

As this feature could be abused, an authentication code must be entered. The security stamp can only 
be set once with each authentication code, further reducing the chances of a carefully set message 
from being changed maliciously.

The activation codes are: “ZAPHOD” and “EDISON”.

The first code allows the initial stamp setting, while the second code allows the security stamp to be 
changed once.
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Loggers with an internal Bluetooth module, such as LogIT Voyager Air, use the first line of the 
security stamp as the Bluetooth device name. It is therefore sensible, with these products, to make the 
first line a unique name.

 18.21 Smooth Channel
The specified data channel is "smoothed". Smoothing helps remove some of the rapid variations in 
value giving a more average representation of the sensor readings. This can be particularly useful if a 
sensor reading includes a significant amount of noise.

The Smooth Channel dialogue is available from the Data menu in SensorLab Standard Edition.

SensorLab Standard Edition provides a simple smooth function. It can be selected more than once to 
further smooth the data.

SensorLab Plus Edition provides variable smoothing. The smoothing dialogue allows the channel to be 
selected and a variable amount of smoothing is applied with a slider. Drag the slider right to increase 
the level of smoothing, and left to decrease it.

 18.22 Smooth
The specified data channel can be "smoothed". Smoothing helps remove some of the rapid variations 
in value giving a more average representation of the sensor readings. This can be particularly useful if 
a sensor reading includes a significant amount of noise.

The illustration below shows the noisy data in blue and a smoothed copy in red.
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Smoothing is available from the Data menu.

SensorLab Plus Edition provides variable smoothing. The smoothing dialogue allows the channel to be 
selected and a variable amount of smoothing is applied with a slider. Drag the slider right to increase 
the level of smoothing, and left to decrease it.

SensorLab Standard Edition provides a simple smooth function. It can be selected more than once to 
further smooth the data.

 18.23 Tare
Tare adjusts sensor readings to add or remove an offset. Typically used to zero a value such as voltage 
or to set pH using a buffer solution. It is a simple single point calibration.

Tare is available from the Data menu.
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For example
If you want to perform really accurate pH measurements you would normally use a buffer solution and 
adjust the probe or use the software's Tare facility. This would fine tune the reading at one known 
point. In this example, a pH 7 buffer solution might give a reading of 7.1 (an error of 0.1). To correct 
this, enter "7.1" in the "Tare from" box and "7" in the "Tare to" box. All values will then have the 
correction applied.
  
Note: This correction is not saved and must be re-entered each time it is required.

 18.24 Unit Conversions
The Unit Conversions dialogue allows selection from a range of common unit conversions. For 
example, degrees Celsius to degrees Fahrenheit. 

Unit Conversion is available from the Data menu.

The list of conversions offered initially contains only those which match the current channel units. The 
“Show all” option adds all available conversions to the list, even those that do not match.
  
Each conversion is based on a gain and an offset value. To perform the conversion, the computer 
multiplies each reading by the gain value and adds the offset value. 
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When the degrees Celsius to degrees Fahrenheit conversion is selected, the gain is 1.8 and the offset is 
32. This comes from the time honoured method of multiplying by 9 and dividing by 5 (9/5 = 1.8) and 
adding 32.
  
If the conversion required is not offered, suitable gain and offset values can be entered.
For example: To convert volt to millivolt, the gain is 1000 (1 V = 1000 mV) and the offset = 0 (0 V = 
0 mV).
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 19 Timing Explained
This section explains how timing works. Note that this is not the same as LogIT Lab 4.

Some sensors are able to generate time interval data from changes in 'digital' levels. Each time a 
change occurs it is reported together with the time in microseconds since the previous change. From 
these event times any complex sequence of events can be timed and calculations applied to work out 
things like Speed, Acceleration, etc.

Some loggers can only provide timing data from digital sensors, while others can obtain timing data 
from analogue sensors as well. 

As an object passes a sensor, a series of times is measured, as illustrated in the timing diagram below.

This could be one object passing two sensors or two objects passing a 
single sensor. This example gives three times: T1, T2 and T3.

By combining pairs of times, such as time 1 and time 2, we get the following result:

This gives greater accuracy as measuring from one leading edge to 
another tends to cancel any errors in the sensing mechanism.

Obtaining a measurement with the second timing method requires more sensors or an object of a more 
complex shape. 

Objects can be any of these basic shapes:

A simple object with only one 'bar'.

An object with two 'bars'.

A four 'bar' object.

Sensors are arranged such that they can detect the 'bars' which form the object being timed.

Objects which consist of more than just a few bars are often called Picket Fences. By using a picket 
fence a sequence of measurements can be made, such as the velocity of a trolley as it runs down a 
slope. The picket fence needs to have a number of bars which is an exact multiple of the number 
required for a single measurement.

A set of event times can be used to calculate a final useful value, such as Speed or Acceleration. If 
required the source event times can be displayed to allow the user to calculate the required value 
manually.

To provide the maximum flexibility, there are also options to determine how to handle multiple 
sensors. The user may wish to obtain one measurement from each sensor, such as the speed at one 
sensor and then at a second sensor, or he/she may wish to measure the speed of an object as it moves 
from one sensor to another sensor.

Timing supports overlay logging.
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 19.1 Single Sensor Measurements
The following measurements can be made with a single sensor:

● Time Difference
● Speed
● Velocity
● Acceleration
● Kinetic Energy
● Momentum
● Simple Harmonic Motion Period

Although only one sensor is required, several sensors may be used to obtain several measurements of 
these types (except for Simple Harmonic Motion period). This might be used for measuring velocity 
before and after a collision.

If more than one sensor is available it is possible to make more than one measurement. Here there is a 
choice of measuring “At any sensor” or “At each sensor”. In both cases a measurement can be made at 
any available sensor. Each sensor can make an independent measurement which may overlap 
measurements being made with other sensors. 

With the option “At any sensor”, when one measurement is complete it is stored in the relevant 
channel and the data record is completed. This may result in some channels containing no data value. 

With the option “At each sensor”, when one measurement is complete it is stored in the relevant 
channel, but the data record is not completed until each sensor has made a measurement. Further data 
from a completed sensor is ignored until the next data record begins.

When Manual Calculation is not selected, one data channel is created for each suitable sensor.

When Manual Calculation is selected, one data channel is created for each time value needed to 
calculate the desired result. For example, Acceleration requires three channels.

When Manual Calculation is selected, only one measurement per record is supported. Thus the option 
“At each sensor” is disabled.

 19.2 Dual Sensor Measurements
The following measurements can be made with a pair of sensors (where the time intervals are 
measured from one sensor to another):

● Time Difference
● Speed
● Velocity
● Acceleration
● Kinetic Energy
● Momentum

The only valid sensor option, when using a pair of sensors for a single measurement, is “From one 
sensor to another”. However, the other options will still be available if there is more than one suitable 
sensor has been detected, as the user may wish to specify that they are to be used for separate 
measurements, as described above in the section “Single Sensor Measurements”.

In all cases only one measurement is made per data record. This measurement is not associated with a 
specific sensor as more than one sensor is involved.
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When Manual Calculation is not selected, one data channel is created.

When Manual Calculation is selected, one data channel is created for each time value needed to 
calculate the desired result. For example, Acceleration requires three channels.

When Manual Calculation is selected, only one measurement per record is supported. Thus the option 
“At each sensor” is disabled.

 19.3 Time, Speed, Velocity, Kinetic Energy, Momentum
These measurements require only one time value, but this can be obtained in a number of different 
ways. The different methods are shown below with timing diagrams.

Sensors = 1 (for a single measurement)
Sensor mode = At any sensor or At each sensor
Object = 1 bar (for a single measurement)

Sensors = 1 (for a single measurement)
Sensor mode = At any sensor or At each sensor
Object = 2 bars (for a single measurement)

Sensors = 2 (for a single measurement)
Sensor mode = From one sensor to another
Object = 1 bar

Objects with more than 2 bars, often called 'picket fences', can be used to create a sequence of 
measurements. The number of bars must be a multiple of the number selected for the specified 
measurement. Each repeat of the basic timing sequence is stored in its own data record.

 19.4 Acceleration
Acceleration is calculated from three times, which can be obtained in any of these ways:

Sensors = 1 (for a single measurement)
Sensor mode = At any sensor or At each sensor
Object = 2 bars (for a single measurement)

Sensors = 1 (for a single measurement)
Sensor mode = At any sensor or At each sensor
Object = 4 bars (for a single measurement)

Sensors = 2 (for a single measurement)
Sensor mode = From one sensor to another
Object = 1 bar

Objects with more than 2 bars, often called 'picket fences', can be used to create a sequence of 
measurements. The number of bars must be a multiple of the number selected for the specified 
measurement. Each repeat of the basic timing sequence is stored in its own data record.

In all cases the value of acceleration is determined from the velocities (calculated from time T1 and 
T2) and the time taken for the velocity to change (= T1 / 2 + T2 + T3 / 2).
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When Manual Calculation is selected the stored times are T1, T2 and T3 as illustrated above. 

 19.5 Simple Harmonic Motion Period 
This measurement is restricted to just one sensor and one method of obtaining the time value.

Sensors = 1  
Sensor mode = At any sensor
Object = 1 bar

An object passes a single sensor three times as it swings or oscillates. If left running a sequence will 
be stored, with one 'period' time in each data record.

 19.6 Manual Calculations
The Manual Calculation option is designed to provide the measured time intervals and allow the user 
to calculate the end result, rather than have the program do it all for them.

One data channel is created for each time value needed to calculate the desired result. For example, 
acceleration requires three channels. These are times T1, T2 and T3, as shown in some of the timing 
diagrams above.

The channel names are “Time 1”, “Time 2”, etc. and the units are “s”.

When manual calculation is selected, only one measurement per record is supported. Thus the option 
“At each sensor” is disabled.
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 20 Bluetooth
Some data loggers support a wireless Bluetooth connection to the computer. This can be used instead 
of connecting with a serial or USB cable. 

When trying to establish a connection to a Bluetooth equipped LogIT product, please do not forget to 
turn the logger on and, where appropriate, select Bluetooth. With a Bluetooth equipped LogIT 
Voyager the Bluetooth connection is selected just after Voyager is turned on by pressing the Blue 
button when prompted. When using the LogIT Air Link adapter with serial loggers, the logger just 
needs to be turned on.

With LogIT Voyager the Bluetooth device name is the first line of the Security Stamp message. This 
can be set from within SensorLab by selecting “Set Logger's Security Stamp” from the File, 
Administrator's menu.

It is recommended that older LogIT Bluetooth products be updated to support Bluetooth pairing codes. 
Early LogIT products did not support pairing codes, but recent firmware updates have added this 
feature. As most recent releases of Bluetooth set up utilities now force the use of pairing codes, it has 
become necessary to update LogIT firmware.

LogIT Voyager should have firmware version 1.07 or later. The version number can be found by 
pressing the blue menu button repeatedly until the display shows the version information. Voyager's 
firmware can be updated by selecting “Reload Logger's System Software” from SensorLab's File, 
Administrator menu.

The LogIT Air Link serial adapter can be updated by DCP Microdevelopments.

The pairing code number used by LogIT is “0000” (four zeros).

It is difficult to give definitive instructions to set up Bluetooth as this depends on the Bluetooth 
utilities supplied with the Bluetooth hardware, computer or operating system, and these tend to change 
over time. An overview is given below of each supported computer platform. For further details 
consult the documentation and help provided with your Bluetooth hardware, computer or operating 
system.

In general the following steps may be required to set up and use Bluetooth:
1. Install the Bluetooth interface drivers for your computer's Bluetooth interface. In most cases 

this is automatic. If your computer includes a built-in Bluetooth interface then the drivers 
should already be installed.

2. Establish a connection from the computer to the LogIT product. This process is often called 
pairing. The pairing code number used by LogIT is “0000” (four zeros).

3. Select Bluetooth within SensorLab from the Options dialogue.

The method required for step 1 will depend on the computer, the operating system and the Bluetooth 
interface in use, and has nothing to do with LogIT hardware or LogIT software.

The method required for step 2 will depend on the operating system and Bluetooth set up utilities in 
use. This is described below.

Step 3 is performed within SensorLab. Select Bluetooth in the Options dialogue (from the Tools 
menu) or in the Administrator's Settings dialogue (from the File, Administrator menu). As with other 
settings in these dialogues, the Options dialogue is available to all users and makes temporary changes 
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only (unless Saving of settings is enabled), while the Administrator's Settings dialogue enables the 
settings to be saved as the default for all users of SensorLab.

 20.1 Linux
The Linux version of SensorLab supports Bluetooth devices named “rfcomm#”, where # is the port 
number. Usually the port number will be zero, making the LogIT Bluetooth port “rfcomm0”.

Hopefully the Linux distribution you are using has fully graphical tools to establish a paired 
connection and assign the rfcomm number. If not the following may be useful for assigning the 
rfcomm number.

Once a pairing is established the command:
hcitool scan

should give the LogIT product's Bluetooth address. This will be something like”00:80:98:96:49:A5”.

Once you have the Bluetooth address, the following commands should set a temporary rfcomm 
assignment as “rfcomm0”:

sudo rfcomm release 0
 sudo rfcomm bind 0 <bluetooth address> 1

To set a permanent assignment, which is established at boot up, you should typically edit the file 
"/etc/bluetooth/rfcomm.conf" to read:
    rfcomm0 {
    bind yes;
   device <bluetooth address>;
    channel 1;
    comment "LogIT Voyager";
    }

 20.2 Mac OS X
The Mac version of SensorLab enables the LogIT bluetooth device to be selected from within 
SensorLab. There is no need to establish pairing outside SensorLab.

From the Options or Administrator's Settings dialogue, select Bluetooth, then click Search and select 
the required LogIT device. 

 20.3 Microsoft Windows
Usually when a Windows computer has a Bluetooth interface, a Bluetooth icon is shown in the 
notification area of the taskbar. Typically this icon enables the following to be achieved.

Using the Bluetooth icon, select Add a Device. This should show a list of devices in range. Select the 
required LogIT device. When asked for a pairing code, enter “0000” (four zeros).

The icon will usually allow the connected devices to be shown. From here details of the device can be 
shown, possibly by selecting “Properties”. This will show the Serial service COM port number 
assigned to the LogIT device. This is the COM port number which needs to be selected in SensorLab's 
Options or Administrator's dialogue.
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 21 Glossary

AutoLog
AutoLog is a totally automatic data logging mechanism. When started it begins collecting data 
relatively quickly and then gradually slows down as the experiment progresses. It can be 
stopped at any time and the data will always be available as regularly stored values. Each sensor 
has a default measurement type (such as averaged value or frequency) for use with AutoLog.

Accuracy
Accuracy is the degree of agreement between a measured value and the standard or accepted 
value for that measurement. Often expressed as a percentage of the full scale value or maximum 
deviation from the accepted value.

Channel
A Channel (or data channel) contains a set of data from one source, typically a sensor, but it can 
be data entered manually. A channel is shown as one column in the table and one trace on the 
graph. A channel also contains a name (eg. Distance), units (eg. m) and description (eg. distance 
up the ramp).

Control Device
A Control Device plugs into a sensor socket and provide an output that can be turned on and off. 
Currently available devices include a Control relay, buzzer and light (LED). They are 
compatible with LogIT Live, DataMeter 1000, DataVision CX, LogIT Voyager SX and LogIT 
Black Box, but not LogIT SL. A special control pack is also available for LogIT Explorer.

Data Logger
A Data Logger is a device used to capture data. For the purposes of this software the term 
Logger refers to either a real time computer interface (such as LogIT Live) or a remote data 
logger (such as LogIT DataMeter 1000). Strictly speaking a real time computer interface is not 
actually logging the data itself and should not be called a data logger. 

Duration
Duration is the total time an experiment logs data for.

Elapsed Time
Elapsed time is the time from the start of logging, usually expressed in seconds. The start of 
logging will thus be at zero seconds and a one minute long experiment will have its last reading 
stored with an elapsed time of 60 seconds.

Experiment
An Experiment is a test or investigation designed to provide evidence for or against a 
hypothesis.

Interval
Interval is the time between each reading being logged.

Level of Sophistication
This software supports four pre-defined levels of sophistication (or User Levels), with the aim 
of offering users appropriate functionality for their ability and experience.

Manager Mode
Manager mode allows access to user settings such as the default location of data files. Some 
items in the administrator menu are only shown when in manager mode. Manager mode can be 

SensorLab User Guide 8 April 2011 Page 80



enabled by pressing the key combination Shift/Ctrl/Alt/T and selecting Manager mode in the 
dialogue displayed.

Microsense
Microsense is the name of the sensor system used by LogIT SL, Live, DataMeter, DataVision, 
SensorLink, Voyager and Black Box.

Noise
Noise is irregular fluctuations accompanying a transmitted signal but not relevant to it.

Oscilloscope
An oscilloscope is an instrument designed to display waveforms, such as sound waves. 

Overlay
Having performed an experiment, you might wish to change one variable and repeat it for 
comparison. Overlay allows you to do this, combining the new results with the old on the same 
graph and table.

Periodic Logging
Periodic Logging is when data is stored at regular time intervals throughout an experiment.

Pre-trigger
Pre-trigger is the time just before the logging trigger occurs. Logging normally starts when the 
user presses the Start button. Triggered logging starts when a sensor detects a trigger level or 
change. This has the advantage of allowing very fast events to be captured. Triggered logging 
mode includes the capture of sensors readings just before the trigger occurs, enabling the 
beginning of the event to be captured. Typically triggered logging supports intervals from 50 
microseconds per reading to 10 milliseconds per reading.

Probe
A Probe (or sensor) is a device that responds to an external signal or stimulus, and in this case 
produces an electrical signal that can be measured by the logger.

Real Time Logging
Real Time Logging is when the results are displayed as they are being collected.

Remote Logging
Remote Logging is when data is collected independently of the computer with a remote data 
logger. Results can then be read (or fetched) from the logger at a later time.

Repeat
An experiment can be performed again with the same settings as the previous session. Select 
Repeat from the Logging menu.

Resolution
Resolution expresses the smallest change in a signal that can be distinguished. Temperature 
sensors typically have a resolution of 0.1 degrees.

Security Stamp
Some data loggers have a Security Stamp feature, allowing a custom message to be displayed 
on the screen. This might, for example, be a name, post code and logger number.

Sensor
A Sensor (or probe) is a device that responds to an external signal or stimulus, and in this case 
produces an electrical signal that can be measured by the logger.
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Smooth
To have a relatively even and regular surface. Smoothing a data channel helps even out 
unwanted variations in value, often called noise.

Snapshot Logging
A single value from each input is stored when the user selects Store. This is useful for 
experiments that are not time dependent, such as measuring magnetic field strength every few 
degrees around a magnet.

SwitchIT
SwitchIT is a control interface providing four changeover relays that can be turned on and off. It 
connects between the computer and the logger. SwitchIT is compatible with LogIT SL, Live 
and DataMeter 1000. 

Tare
Tare adjusts sensor readings to add or remove an offset. Typically used to zero a value such as 
voltage or to set pH using a buffer solution. It is a simple single point calibration.

Timing
Timing is a special form of logging where each measurement is based on the time difference 
between events. The stored value may be the time difference or some value derived from it, 
such as Speed.

Triggered Logging
Logging normally starts when the user presses the Start button. Triggered logging starts when a 
sensor detects a trigger level or change. This has the advantage of allowing very fast events to 
be captured. Triggered logging mode includes the capture of sensors readings just before the 
trigger occurs, enabling the beginning of the event to be captured. Typically triggered logging 
supports intervals or 50 microseconds per reading to 10 milliseconds per reading.

USB
The Universal Serial Bus (USB) is a relatively new connection system, enabling many 
peripherals to be easily connected to a computer. It has many advantages over the older serial 
and parallel ports. A special link cable is available to connect LogIT 'serial' data loggers via 
USB. 

Wizard
A Wizard is essentially an intelligent questionnaire that guides you through a set of questions 
relating to a selected activity. You will only be asked relevant questions, as determined from 
earlier answers and other external factors. The aim is to simplify tasks that might otherwise 
seem complex, especially for inexperienced users.
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